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Class Goal:

The student will demonstrate ability to utilize the major features of the Windows7
operating system at CUA SLIS as well as the workplace or home as well as the special
library science desktop in the IC and lab.

Class Objectives:

e Use the computer lab and multimedia lab resources and describe the procedures
for signing up on the web

¢ Understand the features of the Library Science Lab and IC Desktop

e Understand DeepFreeze environment and saving files to M drive or storage
device

e Explain the network concept and use the "M" drive on the network and My Files
at http://home.cua.edu.

e Locate on SLIS website course catalog, current schedule, syllabi, faculty
information, program requirements, technology resources, courses of study,
academic policy

e Understand the computer specifications for library science graduate students
hardware, software and network access needed.

e Daily access to desktop or laptop conforming to specifications suggested by CPIT
at http://computing.cua.edu/start/sci-info.cfm . Internet connection with access
to and enough capacity to stream video and audio (e.g. You Tube)

e Install software using a CD or DVD and download methods. Software for your
computer, current versions of operating system, word processing, presentation
(MS Office or Open Office) Web Browser (IE, Firefox, Opera), Anti-virus software.

e Use control panel to uninstall software

¢ File formats: Word processing, pdf, HTML and image files

e Use MS Office Word 2010 to format documents and add headers and footers,
tables, insert images, cut, copy and paste text, format text, change margins, and
create bulleted as well as numbered lists.

e Recover files in MS Word 2010 and from trash that were deleted.

e Use Windows Media Player and Quick Time Player




Topic 1 The CUA SLIS Computing Environment Overview

Getting in the door to Marist 131, 131A and 237: There is a keypad with a code which
must be entered properly to make the door open. Enter 4 then 2 and 3 together and
turn the knob to the right. You may use the main lab in Marist 131 unless there is a class
scheduled at that time. You then may use Marist 237 the student computer lab.

Using the computer labs: To use the computers you must have a current CUA User ID
and password. All students have two logon accounts at CUA. The first is your Cardinal
Station account that was mailed to you when you applied to the university. The second
is your CUA Network logon account that is used to log onto lab computers and to access
your cua.edu e-mail. Your CUA Network logon account is created shortly before your
first semester at the university.

Once it has been created, you can find your CUA Network account information by
logging onto Cardinal Station at http://cardinalstation.cua.edu.

The Catholic

My Station

1. Navigate to Cardinal Students.
* My Favorites

* Facylty _Service
* Cardinal Students
#* Class Search / Browse Catalog
= Change My Password

Enterprise Menu
# My Favarites
# Faculty Self-Service

- Cardinal Students 2. Select the Self-Service tab.

=l Self Senvice i ) )
# Enrollment 3. Navigate to CUA Logon Accounts. This page lists
+ Campus Finances your CUA Network account username and e-mail

el e PRI address, and instructions on how to log on for the
= CUA Logon Accounts

— e first time.

= Mames
= Phone Mumbers
= Email Addresses




How do | reset my CUA network logon password?

If you know your current password and would like to change it, you can do this at
home.cua.edu. If you do not know your password, you can contact the Center for
Planning and Information Technology (CPIT) at: 202-319-4357.

Keep in mind that your network logon password expires every 90 days and will need to
be changed. You can change your expired password by using it to log onto
home.cua.edu. For more information about passwords, please visit our page about

logging on.

Signing up to use the Computer Labs

You may sign up to use the Marist 131 and 131A computer labs via the School of Library
and Information Science website at: http://slis.cua.edu/tech/slislab.cfm and checking
the hours of opening as well as the current calendar of reservations then sending an
email to cua-slislab@cua.edu. If there are no conflicts, your reservation will be
recorded on the calendar and you will be sent a confirmation.

Sign up for Multimedia Lab 131A at: http://slis.cua.edu/tech/mediaform.cfm and check
the calendar for availability then complete the web form. If there are no conflicts, your
reservation will be recorded on the calendar and you will be sent a confirmation.

SLIS Desktop

The Catholic University campus computers are networked with the Windows 7
operating system. In addition, the campus has a site license for the MS Office 2010

applications. The first time you use one of these programs you will need to provide your
name and initials.

Microsoft Office

@ Microsoft Access 2010

|&] Microsoft Excel 2010

|I| Microsoft InfoPath Designer 2010
|I| Microsoft InfoPath Filler 2010
|E| Microsoft OneMote 2010

| Microsoft Qutlock 2010

|E| Microsoft PowerPoint 2010
|E| Microsoft Project 2010

[B] Microsoft Publisher 2010

[M] Microsoft Visio 2010

(W] Microsoft Word 2010




The SLIS desktop also has a folder with special library science applications. Please use
the programs for your courses and projects.

Share with ~ Burn Mew folder =~ I @&
T ’ o = .
f ol a
\ [ I l
L v
Adobe Web Greenstone-2.83 Cataloger's Classification Dialog ImageMagick Lexis
Premium C55 Desktop Web Display

QOCLC Connexion Westlaw
Client 2.20

In this folder you will find the Adobe Web Premium CS5 high-end web developer’s
software to include:

A= Acrobat Distiller 9

|§i|r Adobe AcrobatQ Pro

Pl Adobe Bridge CS5

7l Adobe Contribute C55

EEl Adobe Device Central £55

@ Adobe Dreamweawver C55

E Adobe ExtendScript Towolkit C55
Eﬁ Adobe Extension Manager C55
'3l Adobe Fireworks C55

5l Adobe Flach Builder 4

"%l Adobe Flash Catalyst C55

E Adobe Flash Professional C55
7l Adobe Help

2l Adobe lllustrator €55

k. Adobe LiveCycle Designer ES 8.2
Adobe Media Encoder C55

E Adobe Photoshop C55 (64 Bit)
'l ~Adobe Photoshop S5

E Adobe Pizel Bender Toolkit 2
@ Adobe Reader 9




By clicking on the icons in the folder, library school faculty and students will have access
to the following:

. DLink for Dialog searching.

. Cataloger’s Desktop for cataloging tools.

. Connexion to catalog in OCLC

. Lexis Research Software to search Lexis-Nexis.

. Westlaw to use legal research tools.

Campus classroom computers also have:

Deep Freeze: S - is software that gives users the ability to make
changes to the desktop and programs, but when the computer is rebooted, all the
changes are erased. The Lab PCs in 131 have Deep Freeze installed which means if you
save information or make changes to the Desktop it will be erased as soon as the

computer is rebooted. Please save your work on a Flash/memory stick or to the shared
network drive.

Web browsers: SLIS will have two web browsers:

@ Internet Explorer

Internet Explorer 8.0

Mozilla Firefox
@ Mozilla Firefox (Safe Mode)

@ Mozilla Firefox Modzilla Firefox 3.6.8

You may be asked to add applets to Mozilla Firefox and these would be erased after the
computer was rebooted.

Windows7 Topics: For answers to special Windows XP topics, check
http://www.microsoft.com/windows?7

CPIT: For information, check the CPIT web site at: http://computing.cua.edu. If you

are having problems, enter a support ticket online. Visit help.cua.edu to start the process.
In addition to requesting help, most technology work orders, both for computing and telephone,
can be made this way.




Further Getting Started Tips: Available through CPIT at:
http://computing.cua.edu/start/index.cfm

Main Programs

You may launch programs from the Start menu, by clicking on All Programs

> All Programs

|Search program
Search progro

s and files o |

Windows Explorer

In the Windows7 hierarchy, the Windows Explorer icon is on the desktop. It provides

access to disk drives on the computer and on the network such as the “M” drive. It also
provides access to Printers and Control Panel.
To open the Windows Explorer window, double-click on the Windows Explorer

[
| icon on your desktop. The window displays icons representing objects
on your computer. You can restore, resize, and close this window as you can any other

window.

Drives on Windows7 PC

C:\ drive is the hard drive to
store system files and
programs.

E:\ drive is for CD-ROM’s.
F:\ drive is for your flash
stick.

M:\ drive or another letter
is for the network drive that
students can use to store
shared files or save files on
the server.

4 L. Fawvorites
Bl Desktop
& Downloads

=l Recent Places

4 - Libraries
> ;:I Docurments
> J‘: MMusic
» =] Pictures

> E Videos

4 1M Computer
- &L, Local Disk (C3)
» 5 CD Drive (E:) U3 Systern
 amw Pemovable Disk (F:)
> m WEEKSS (WMcuasent)) (M:)

THdTTTE

_WEB

. cataloging

. desktop

. keysearch
B aladin.doc
catdeskerrorJPG
collagelweeksError.jpg
IEIJ computerworkshop.doc
|E| DSC_0851.AV1

i, ExportFile_lsc820.zip
& | indexa.html
B keysearch.doc
leftarrow.gif
logo.gif
B MARC.ppt




Topic 2 Saving your Files on the M:/drive or home.cua.edu

Your network account provides you with a space on the network to store documents.
You may then retrieve your documents when you return home.

Steps:

1. When you are on campus and logon to a computer you are automatically able to
access your shared space on the server.

2. Use the Explorer Icon and locate your M:\ driver user name folder.

3. Double click on your folder to reveal the contents. You should see a _WEB folder
to publish web pages on the server.

" Mame
4 M Computer
- &, Local Disk (C:) | _WEB
» &4 CD Drive (E:) U3 System . cataloging
" e REmMovable Disk (F:) . desktop
» L WEEKSS (Wicuasentj) (M:) . keysearch
W Aladin.doc

4. Off campus you may retrieve your files by entering URL: http://home.cua.edu.

5. Enter your User name and Password.

Log In { Password

Passwurd::l

Forgot your password?

6. Locate and click on My Files. |

My Files

Click here to access your
personal and website files




7. You may want to create a folder for each class or project.

Create Folder?

| | Create

— (3 _WEB [website]
~ [ cataloging

~ [ desktop

— (3 keysearch

8. You may download the files you saved on campus by right clicking on the file and
downloading it to your PC.

e R e L

[ Aladin.doc

9. You may upload files on your pc to access on campus by clicking on Browse and
then navigating to the file. Once you have selected the file, click Upload.

T TWICTOST UICE FTOJECT STarnart SULS SETUPTUUUTLTRT T OU TR UTTZTTEWTT T T30 T T
[ MIV-Install-bothOS_pdf 72528 Kb 11/19/2008 01:01:56 AM
Upload a File: || Browse... | Upload

10. Once the file is uploaded you will be able to access it again via the M:/drive on
campus or via home.cua.edu anywhere there is an Internet connection.

Topic 3 Using the SLIS website http://slis.cua.edu

As you progress through the Master’s Program, it is very important to locate the
resources you need on the SLIS website.
v About El
Course catalog: In the navigation bar, click | » Admissions =
the Course Information area to review the » Calendar and Events
Course Catalog. " Course information -]

= Course Catalog



Current schedule: Click the
Course Information link to » About [+] Class Schedules
reveal “Course Schedules”.

» Admissions |E| CUA Academic Calendar
v Calendar and Events
Fall 2010
~ Course Information
Summer 2010
* Course Catalog
* Courge Schedules Spring 2010
Syllabi: Each semester’s schedule —
will have syllabi icons next to each Information Systems in Libraries and Information Center
class. Ingtructor: Choi, Youngok
Click the icon to retrieve the
syllabus.
= About

Faculty information: Click the About link

. * Mis=ion
to reveal “Faculty Directory”.

* Accreditation
* Maps & Directions
* Contact Us

v Faculty Directory

Program requirements: Click the Program | , 1pqut
Overview link to reveal the “Masters
Requirements.

-

Admissions

-

Calendar and Events

-

Course Information

-

Forms and Paolicies

Program Owverview

IR R KT R K N KT

= Masters Reguirements

Courses of Study: Click the Program * Program Overview [*]
Overview link to reveal the “Courses of « Masters Requirements
Study.

= Jloint-Degree Programs

= Courses of Study

«Q
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Academic policy: Click the
Forms and Policies link to
reveal the “Academic
Policies.”

Technology Resources:
Click the Technology
Resources link to reveal
information about the
Computer Labs, Computer
Support Contacts, the
Information Commons and
Listservs.

v About

-

Admissions

-

Calendar and Events

-

Course Information

* Forms and Policies

-

Program Overview

-

-

Technology Resources

Tuition and Financial Aid

Faculty Handbook
Academic Policies

ACADEMIC

FORMS AND POLICIES

University Policy Guides

Graduate Student Policies

Folicy documents and forms

[ M ML

Policy Information

Ri

v About

v Admissions

k

k

3

k

Calendar and Events
Course Information
Forms and Policies

Program Overview

* Technology Resources

* Computer Labs
* Computer Support Contacts
* Information Commons

* Listzervs

[ O G

SLIS Students & Faculty
Technology Resources

5LIS Computer Lab

» Mission

* Hours

« Staff

» Locations

» Availability & Reservations

5LIS Technology Workshops
Listserv for SLIS communities
Technology Resources

= Test gut a Kindle e-book
reader on loan!

Topic 4 SLIS Software Recommendations

As a graduate student in the Master’s Degree program, you will need daily access to
desktop or laptop conforming to specifications suggested by CPIT at

http://computing.cua.edu/start/sci-info.cfm and an Internet connection with access to

and enough capacity to stream video and audio (e.g. You Tube)
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Student Computer Initiative
The Student Computer Initiative offers several venues from which to purchase computers at discounted educational prices.

Before purchasing a computer, please review the recommended system configurations on this page.

Dell Computers

The Dell purchasing program
offers discounted
educational prices.
Visit the CUA page at
Dell.com

Apple Computers

Apple computers may be purchased at educational prices through the CUA Apple Education Stare.

Recommended System Configurations
Minimum Recommendations for Microsoft Windows Computers

Desktop. An example of a good mid-level desktop computer is one that has: Architecture students:

» Processor: Intel Core i5 or i7 processor plea_se Clwk‘. here for

. MEH’IDW: & GB DDR3 SDRAM SpECIﬁC reguirements.

» Video Card: 512MB PCl Express x16

* Hard Drive: 1TB SATA 3.0Gb/s 7200 RPM

« Optical Drive: 16X DVD+/-RVW DL

+ Display: 20 inch HD widescreen flat panel

» Communications: internal 10/100/1000 Ethernet LAN card (consider adding an internal 802.11n wireless network card)
= Operating System: Micrasoft Windows 7 Home Premium, Professional or Ultimate 64-bit

* Productivity Software: Microsoft Office Home and Student 2010

» Other Software: Enhanced software for DVD writer

In addition, you should have current versions of operating system, word processing,
presentation (MS Office or Open Office) Web Browser (IE, Firefox, Opera), and Anti-virus
software. The campus bookstore as well as Academic software websites offer discounts
on software and you are eligible for these discounts.

12



Topic 5 Installing and Uninstalling Software

You may use either of two methods to install software:

Using a Media Disc
Steps:

1. Insert the disc in the disc drive.
2. The installation wizard should
start and guide you through the
installation. Generally, you
should select the Express
installation rather than custom.
Your software will then download
to your computer and the
installation process will begin.

3. You will need to have your
license key available to insert into
the dialog box.

Windows Installer

_ilzl Preparing to install...
=
&

Cancel

From a Website Download area

Steps:

1. After you have purchased
software online, you should be
taken to a download button.

2. Click the download button and
your software should
download to a temp folder.

3. Select Run to use the set up
wizard.

File Download - Security Warning =

Do you want to run or save this file?

@ Mame: ClientMet?_20.exe
Type: Application, 44.6MB

From: psw.oclc.org

[ Run ] [ Sawve ] [ Cancel ]

[ e | While files from the Intemet can be useful, this file type can
\ potertially harm your computer. F you do not trust the source, do not
— run or save this software. YWhat's the risk?

13




Un-install programs
Steps:

1. Click the Start
button and Control
Panel.

2. Click on the
Programs and
Features link open a
window with
Uninstall or change
a program.

3. Select the program
you want to
uninstall.

4. Click Uninstall.

5. You may need to
delete icons from
your desktop later.

Topic 6 File Formats

== Metwork and Sharing Center
B personalization
EL? Programs and Features

& Region and Language

Control Panel Home

View installed updates

Uninstall or change a program

Turn Windows features on or

i Organize »

Install a program from the =

network Name
Adobe Acrobat 9 Pro - English, Frangais, Deutsch
Adobe AR
Adobe Community Help

Adobe Creative Suite 5 Web Premium
Adobe Flash Player 10 ActiveX

Adobe Flash Player 10 Plugin

Adobe Media Player

Adobe Reader9.3.3

Amos 18

| Apple Application Support

[AS AutoCAD 2011 - English

| AuteCAD Architecture 2011 - English
| Autodesk Design Review 2011

| Autedesk Material Library 2011

| Autedesk Material Library 2011 Medium Image library
| Autodesk Revit Architecture 2011 b4
| CutePDF Writer 2.8
|_|FAROL51.1.406.58

TmansManick f £ 2.0 O1A (010.07-151

1

To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

Publisher

Adobe Systems

Adobe Systems Inc.

Adobe Systems Incorporated
Adobe Systems Incorporated
Adobe Systems Incorporated
Adobe Systems Incorporated
Adobe Systems Incorporated
Adobe Systems Incorporated
SPS5 Inc,

Applelnc

Autedesk

Autedesk

Autodesk, Inc.

Autedesk

Autedesk

Autedesk

FARQ Scanner Preduction
TmaneManick Shidin 11 C

A=

- \_:Q:.
Installed 1 *
7217201
7/21/201();
77217201
8/6/2010
8/6/2010
8/6/2010
7/21/201¢
8/2/2010
6/10/201(
6/8/2010
6/16/201(
11172010
8/6/2010
11172010
6/16/201(
11172010
/6/2010
6/16/201(

7200 7
[

You will need to save files with the proper extensions to insure the computer programs

will retrieve them without corrupting them. SLIS Lab and IC computers have been re-

imaged with MS Office 2010. Many of your fellow students or co-workers may not have

MS Office 2010. Also, you may not have Office 2010 at home and may want to either

save documents in what is called “compatibility mode.” This action will save the
document with the old extension. You may download and install the free compatibility
program at: http://www.microsoft.com/downloads/en/default.aspx

14



New MS Office 2010 software on SLIS computers:

Any of the programs can be launched
from your Start Menu.

As soon as the program opens you will
notice a new look and feel with what is
called the “ribbon.”

A major starting point is the File tab in
the upper left corner.

Saving documents

1. Click the File tab.

2. Select Save As and as the menu
opens, select Word 97-2003
document, if you want to save
them in the earlier format.

, Microsoft Office

@ Microsoft Access 2010

if| Microsoft Excel 2010
m Microsoft InfoPath Designer 2010
m Microsoft InfoPath Filler 2010
|E| Microsoft OneMote 2010
0] Microsoft Outlock 2010
|E| Microsoft PowerPoint 2010
[B] Microsoft Project 2010
(B] Microsoft Publisher 2010
(M] Microsoft Visio 2010
(W] Microsoft Word 2010

. Microsoft Office 2010 Tools

W 0 - U IR
Home Insert Page Layout

| =l save |
Save As

Informatiq

F\Documents'lal

lj Open
Lﬂ Close

e
Recent | Convert

.i. Home 1
| H Save |
Save As

Lj Cpen

o Close

Perhaps you want to save as MS Word .doc as the default instead of. docx.

15



Conversion of MS Word 2010 .docx to MS Word 2003 .doc extension for

default
Steps:
1. Open MS Word 2010 with the File tab and go to Word Options:

.i. Home 1
| HSa\re |

Save As

[ﬁ Open

o Close

2. Select Save as then use the drop down and select Word 97-203 Document

(*.doc)
T — -
Save As |
= = T = —— = =
Lafas) = b « labstaff » Workshops » Fa20l0 ~ | 42| |Efr-:h Fa2010 o
Organize = Mew folder o= * @.
i Mame Date modified Type
4 Libraries :
ﬁl_, @J Draft Fall 2010 Workshop.doc 8/7/2010 1:00 PM Microsoft W
|°%] Docurnents : ; i |
J" i W] GeneralComputingWksp.doc 8/4/2010 9:44 PM Microsoft W
usic
e 1] SLISComputingEnvironWhksp2010.dac 8/9/2010 7.02 PM Microsoft W
[ Pictures -
E Videos
1M Computer 1
&L Local Disk (C)
CD Drive () U3 &
o= Removable Disk |
% WEEKSS (cuase _ | o 7
File name: SLISComputingEnvirenWksp2010.doc -
Save as type: |Word 97-2003 Document (*.doc) -

3. Click OK.
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File formats: You will need to save your files with the proper extensions in

order to retrieve them.

File Type

Program

Extension

Word Processing

MS Word

.doc or docx (2007 or 2010)

Corel WordPerfect

.wpd

Presentation

MS Powerpoint

.ppt or pptx (2007 or 2010)

Spreadsheet MS Excel Xls or .xlIsx (2007 or 2010)
Relational database MS Access .mdb or .mdbx (2007 or 2010)
Portable Document Format Adobe Reader .pdf
Hyper text Hypertext Markup Language .htm or .html
Images Graphical image format .gif
Joint Proprietary Experts
Group .jpg
Tagged image format tif
RealAudio
Audio Real player .ram
MP3
Window Media Player mp3
WAV (WaveForm)
Window Media Player -wav
Moving Image MPEG
(Motion Picture Experts
Windows Media Player .mpg4
QuickTime
QuickTime Player .mov

17




Topic 7 Exploring the MS Word Ribbon

The Opening view of the ribbon for MS Word is displayed with the Home tab highlighted. You
will see familiar toolbar formatting. Notice the sections for font, paragraph, styles and editing.
You can select a tiny arrow at the bottom of each section to open more options for that section.

TH 9 - O
Home Insert Page Layout References Mailings Review View Add-Ins Acrobat Format Design Layout
= 4 - i ¥ I S i
Ba Copy CalibrifBody) ~[11 ~|A A" | Aa~ || == 57 T 4aBbCcl MaBbCcD AaBbCcl A
Paste = o aby . | E=E=E == t=- = i i
> }'FormatPainter [E| i | abe X, X 2 - A |i === d Emphasis THeadingl T MNormal
Clipboard l Font ] Paragraph Fl s

Once you click the small arrow next to font a familiar font menu will open

Home Insert Page Layout References Mailings Rew
Cut i - .
ot Calibri (Body) =~ 11 - A A"  Aa- 2, = 4

& Copy
(B - : By . A - [E=
# Format Painter iy L U abe x, x — =

board ] Font I .I

= 9 [
Font | Advanced

Font: Font style: Size:
+Body Regular 11

Adobe Caslon Pro i 1
Font olor: Underline style: Underline color:
Automatic |Z| (none) IZI Automatic
Effects
[7] strikethrough [7] shadow [ 5mall caps
[ bouble strikethrough 7] outline [T] Al caps
[7] Superscript [7] Emboss [ Hidden
[7] Subseript [T Engrave
Preview
+Body

|| This is the body theme font. The current document theme defines which font will be used.

Text Effects [ OK ][ Cancel
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Bulleted and Numbered Lists

On the Home Tab, you may add bulleted and Mailings Review View
numbered lists.

n.

i

Aa- | B, = isfe s
Steps: B2 . A -

]
]
il

P

1. Click on the bullet icon for bulleted
lists and the number icon for a

numbered list.

2. Click enter at the end of a line to add
the next bullet or number. (You then
may shift click the end of the line to
add a space if desired.

The Insert tab is particularly useful. You can quickly make a table, insert an image or hyperlink,

add page numbers, headers and footers as well as special features like the date and time.

Home Insert Page Layout References Mailings Review View Add-Ins Acrobat Design Layout

1 = [ 1w = . 1 =} =t I 1
= R al e iy Eﬁ o @ = = =| = =
= I & EHE 1 = K el = = #
Cover Blank Page Table Picture Clip Shapes SmartArt Chart Screenshot | Hyperlink Bookmark Cross-reference | Header Footer Page
Page~ Page Break - Art ¥ ¥, Number -
Pages Tables lustrations Links Header & Footer

Let’s try to insert a table. Tables are useful for aligning information in columns or rows.

Steps: — El=l _IPShapes
|Jl
il Z_Z']Smartﬁr
Tahkle

1. Select the Insert tab and click on the

Picture  Clip
Table icon. - art il Chart
2x1 Table
2. Roll your mouse over the squares for DDDDDDDD
the number of rows and columns you .k. OO0 000

want. I O
. _ I { | I I | [ O
3. Double click and your table will DDDDDDDDDD

Insert. I { I I | [ O
N O
N o o

j Insert Table...
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You may also insert a Picture either from an
image on your hard drive or clip art.

Steps:
1. Select the Picture icon

2. Navigate to the place on your pc
where you stored the picture.

3. Click insert.

Insert FPage Layout

| HE
Table Picture Clip
k ~ Art

Tables

Pictures library

Includes: 2 locations

r

Sample Pictures

Headers and Footers

You may want to add a header or footer for
items such as page numbers, dates and
headings that will appear on every page.

Steps:
1. Select the header or footer icon

2. You will see several formats from
which to choose.

3. Click the format you would like and
then start to type in the header or
footer.

4. You may insert page numbers from
the Page Number icon.

=

=

Header Footer
- - ﬁ

Header & Fol

Blank

[Ty ixl]

B

B

nk (Three Columns)

[Type: tend |

e

Footer Page
7 Mumber ~
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The Page Layout tab is also very useful. You can quickly change the page orientation. Don’t

forget to use the Tiny arrows to locate dialog windows for Page Setup and Paragraph.

nsert | Page Layout | References Mai[ings Review View Add-Ins Acrobat

__?\ IE = = Breaks ~ @ D Indent Spacing
— —  £3 Line Numbers ~ - ‘EE Left: |0° *< Before: Opt

Margins Orientation Size Columns " Watermark Page Page v : = :
19 5 - - - - be Hyphenation ~ | - Color~ Borders | == Right: 07 - | = Aften Opt -
Themes | Page Setup m Page Background Paragraph B
. r
the Page Setup dialog Page Setup R
gives you the ability to set
. Margins | Paper | Layout
up margins
Margins
Top: iy} El Bottom: 1" El
Left: 1,25 =) Right: 1,25 B
Gutter: " Iil Gutter position: Left n

The References tab has some nice features you may want to explore. You can manage your

citations very easily and even choose your style. You can easily format an index or table of

contents.

Home Insert Pége [éyuu:i: References Mailings Review View Add-Ins Acrobat Design La]ruuf

[ Add Text ~ AB]_ L-‘:f;l]Insert Endnote _;_ ﬁh‘lanage Sources

E] Insert Table of Figures 2] Insert Index

|2 Update Table M_?‘ Next Footnote + — (R, style: APA Fiftt - (=¥ Update Table 2 Update Index
Table of Insert B Insert . o Insert i Mark
Contents ~ Footnote = Show Notes Citation ~ i) Bibliography = Caption [(f Cross-reference Entry
Table of Contents Footnotes [F1 Citations & Bibliography Captions Index

The Acrobat tab has some nice features you may want to explore. You can manage your

citations very easily and even choose your style. You can easily format an index or table of

contents.

Insert Page Layuut References MaiIir:lg's View Add-Ins Acrobat
g =
Create Preferences Create and Iail Create and Send  Acrobat
PDF Attach to Email Merge Faor Review Comments =
Create Adobe PDF Create and Email Review And Comment
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Topic 8 Using an Audio Player

Types of Audio Files

In a number of special digital collections on the Library of Congress website as well as all
across the Internet, users will encounter audio files that require special applications on
the computer to play them. When recording files for the Internet only certain types of
file formats will work with each application. In this unit, we will explore the audio file
formats found on the Library’s web pages and ways they can be played.

MP3

MP3s have a lossy format that results in a much smaller file size. Lossy compression
reduces a file by permanently eliminating certain information, especially redundant
information. When the file is uncompressed, only a part of the original information is
still there. Most listeners cannot tell the difference. The advantage of lossy methods
over lossless methods is that in some cases, for example in audio files, a lossy method
can produce a much smaller compressed file than any known lossless method, while still
meeting the requirements of the application. It is important to note all media storage
methods are lossy when a live event has been recorded. Current recording methods
only capture a small fraction of the total performance.

Lossy methods are most often used for compressing sound, images or videos. If word
processing documents were compressed this way, data would be lost and this would be
unacceptable. Audio can often be compressed at 10:1 with imperceptible loss of
quality, video can be compressed immensely (e.g. 300:1) with little visible quality loss.
Lossy compressed still images are often compressed to 1/10th their original size, as with
audio, but the quality loss is more noticeable, especially on closer inspection.

When a user acquires a lossily-compressed file, (for example, to reduce download-time)
the retrieved file can be quite different from the original while being indistinguishable to
the human ear or eye for most practical purposes.

RAM

Real Audio is an audio format produced by RealNetworks. It employs a variety of audio
specifications ranging from low-bitrate formats that can be used over dialup modems,
to high-fidelity formats for music. It can also be used as a streaming audio format, that is
played at the same time as it is downloaded. Many internet radio stations use RealAudio
to stream their programming over the internet in real time.
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WAV

This is a standard Microsoft windows Waveform audio file format. It is close to the AIFF
format used by Macintosh computers, and both WAV and AIFF files can be
interchanged. The WAV file can be compressed but most WAV files are uncompressed
and thus can be quite large.

Topic 9 Program Applications for Audio Files
Audio files require that special applications be downloaded and installed on your
computer to enable you to hear them. Here are some links to the most commonly used

applications in the Library.

Apple Quick Time: http://www.apple.com/quicktime/download/

Apple CuickTime

Fil= Edit Mowie Favortes ‘window Help

Free Song of the Week
S. Store Only

Me Llaman Calle

Manu Chao

U.S. Store Only

Afro Samurai
Season 1

Rockstar Tezuka anime
Mickelback Astro Boy
Melody Day Stargate SG-1

Caribou Season 1

Movie Trailers
Check out the latest trailers

You Are the Music In Me
Gabriella & Tray

Stronger Wild Hogs

Kanye West Comedy
Timebomb High School Musical
Beck Kids & Family
Bubbly Legally Blonde

Colbie Caillat
More Top Songs

Comedy

More Top Movies

Quick Tip ~ QuickTime Pro
Week

Your movies.
On a screen near you.

ﬁ!g:—' =
Check out the A Get the scoop
latest game shortcuts and  on the making
The Sim= Life  tachnigues. of Cart=l's
Stories. new album.

iy
Chamberiain.

B8:e8:08 T .
LUl G

S COLLEOO

Notice the Volume control slider on the left and the Play/stop button in the center.

Real Player: http://www.realplayer.com

FealFiayer File  Wiew = =4
] || 9000024 - Library of Congre & khps #:11 (421 350

T~

y

P T
a) 0 (43)
I‘a. 7 k_H_r—-.H_,-’I EE Y l“_-'

i:l;) Real Guide (05 Music & My Lbrary T Music Stars

Notice the stop button at the left and the volume control on the right.
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Windows Media Player:
http://www.microsoft.com/windows/windowsmedia/download/alldownloads.aspx

@ Windows Media Player [ Cfpls] ﬁ
) ! Library » Music » All music Play Burn Sync
Organize v  Stream v  Cresteplaylist ~ 2 'l_\'_fsf-:i'- ye) v|@

Album t Title Length  Rating Contri... =
Bl Weeks, Joan 5. Bob Acri
o] Playlists Bob Acri 3 Sleep Away 320 Yy BobA.
4| J3 Music| Bob Acri
@ At sz I
=) Album 2004
1) Genre
H Videos
| =T
|= Pictures W Sensft
= Recorded TV e
= Ninja Tuna 1 Kalimba 5:48 ek Mr. Sc.
. |mescruf g | N A !
(=) U3 System (E) Mt Scruff E
Electronic
[ﬁ*’ Other Libraries Derrrsts | o8
ninja tuna
Richard Stoltzman
Fine Music, Vol. 1 2 Maid with the Flaxen Hair ~ 2:49 otk Richar..
Richard Stoltzman
MGG 2y | Classical |
—— | 2008 A
m Bdeoclia Caned

Notice the Play button on the left, the slider to advance in the center and the volume
control button on the right.

Sound
Recording About the Format Players
Formats

Audio Video
Interleave
.avi

-Widely used to store both audio and video

. -Windows Media Player
files
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- Minimizes download time

RealAudio |- If you have trouble using RealAudio, -Windows Media Player,
(.ra, .ram) |/download the most recent version of -Mac: RealPlayer
RealPlayer
. . - Windows: Media Player
MP3 - Offers high-quality sound _ Mac: QuickTime
(MPEG 2,

Layer 3, .mp3)||- Downloads faster than WAV files

- Higher-quality format

- Must download completely before playing

WAV - Longer download time - Windows: Media
(WaveForm, Player
.wav) - Windows operating systems contain WAV |- Mac: QuickTime
players

- Some browsers contain media players that
play WAV files

Audio Files on the Library of Congress Website

The American Memory Website has a wealth of musical recordings and famous
speeches that use this special audio file formats. We will explore web pages that use
each of the formats we have discussed.

Exercises:

1. MP3 windows media.com
From the Folklife Collection on the American Memory site, at the Fort Valley State Folk

Festival: http://memory.loc.gov/ammem/ftvhtml/ftvbibPerformersl.html, select a
performer and listen to the music.

What program is needed for this file format?
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2. RA or RAM

From the American Leaders Portrait Gallery on the American Memory site at:
http://memory.loc.gov/ammem/nfhtml/nfgall.html. Click on the link for a speech
from a speaker of your choice. Select the RAM format.

What program is needed for this file format?

3. WAV
On the American Memory site, at the Fiddle Tunes of the Old Frontier: The Henry Reed
Collection, select a title and listen to the song at:

http://memory.loc.gov/ammem/collections/reed/title.html, using the WAV format.

What size is this WAV file?

What format on this page is the smallest?

Why would someone want a smaller file size?

Topic 10 Types of Video Files

There are many different analog and digital film formats in the Library’s collections. The
Motion Picture Broadcast and Recorded Sound Division is the archival repository for
these collections. Only a small portion of the analog historic films has been digitized for
the Internet. Other films were “born digital” and never existed in an analog format. In
this unit, we will explore the video file formats found on the Library’s web pages and
ways they can be played.

MPEG - .mpeg

Moving Picture Experts Group (MPEG) files require that you have sufficient processing
speed, internal memory, and hard disk capacity to retrieve and play the usually large
MPEG file. It can use special compression techniques, called lossy data compression, as
we saw with the audio files. Lossless compression schemes are sometimes used and are
reversible so that the original data can be reconstructed, while lossy schemes accept
some loss of data in order to achieve higher compression.
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You also need client software that plays MPEG files and we will discuss this in the next
section on programs needed to play video files.

MOV - .mov

MOV is a movie file container format developed by Apple Computer to run multimedia
files in its QuickTime player. .mov is a file extension used by the QuickTime-wrapped
files. MOV can contain video, animation, graphics, 3D and virtual reality data. Movie
files are uncompressed and thus can be quite large and cause download problems with
slower dial-up modems. Though MOV files are quite often found in the web, to play
them on Windows computer one has to install an extra component or convert them to
other formats.

RAM - .ram

RealNetworks developed .ram files to open its RealPlayer application, and play both the
audio and video files. These media skin RAM files contain the URL of the audio/video file
located on a remote server. It employs a variety of audio and video specifications
ranging from low-bitrate formats that can be used over slower dialup modems to high
speed Internet Connections. The Library is using this format in its webcasts.

Topic 11 Program Applications for Video Files

Video files also require that special applications be downloaded and installed on your
computer to enable you to see and hear them. For the most part these are the same
applications we used for audio files. Here are some links to the most commonly used
applications in the Library.

Windows Media Player:
http://www.microsoft.com/windows/windowsmedia/download/alldownloads.aspx
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|§| Windows Media Player &@ﬁ
L) » Library ¥ Music » All music Play Burn Sync
Organi i z @
rganize *  Stream v  Create playlist P~ QJ
Album ¥ Title Length  Rating Contri.. = *
Bl Weeks, Joan 5. Bob Acri
o] Playlists Bob Acri 3 Sleep Away 320 phykek Bab A...
4| JJ Music| Bob Acri
& it iz I
=) Album 2004
5 Genre
5 Videos
fl i pi
) ficiees Mr. Scruff
=| Recorded TV .-
= Ninja Tuna 1 Kalimba 5:48 Ty ek Mr. Sc...
() U3 System (E) MrSCruf F S - g
) Electronic
[f® Other Libraries e
ninja tuna
Richard Stoltzman
Fine Music, Vol. 1 2 Maid with the Flaxen Hair ~ 2:49 Rk Richar..
Richard Stoltzman
RICHARD :
STOLTZMAN Classical I
3 2008 B
Q Moo Sl

Notice the Play button on the left, the slider to advance in the center and the volume
control button on the right.

Apple Quick Time: http://www.apple.com/quicktime/download/ . This player was
developed by Apple Computers and will play the MOV format video files discussed
above.

Apple QuickTime e

Eile Edit Movie Favartes Window Help

TALIB KWELLEAR DRULV
g > ML Tozuka anime

) { e ) y I v Astro Boy
N |

LA > On } Stargate SG-1
. A } Season 1

Free Song of the Week Free
U.5. Store Only U.S. Store Only
Afro Samurai

Me Llaman Calle
Season 1

Manu Chao

Rockstar
Nickelback

Melody Day
Caribou

Movie Trailers

You Are the Music In Me
T Check out the latest trailers

Gabriella & Troy

Stronger wild Hogs
Kanye West Comedy
Timebomb High School Musical
Beck Kids & Family
Bubbly Legally Blonde

Colbie Caillat Comedy

st sl More Top Movies &3

QuickTime Pro

Your movies.
On a screen near you.
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Notice the Volume control slider on the left and the Play/stop button in the center.

Real Player: http://www.realplayer.com. This player was developed by Real Networks
to play the .ram files discussed above.

@ealriayer Ele Wiew » [=]
:._}:.J_.J = 9000024 - Library of Congre & Kbps 411 4:2%\\‘5‘)
I L -
(=) () =) (©
@ Real Guide (70 Music & My Library 7 Music Store

Notice the stop button at the left and the volume control on the right.

Motion
Picture About the Format Players
Formats
MPEG
(Motlon - Highest-quality files are in the MPEG format Windows: Media
Picture Player
Experts g . Mac: QuickTime
-A fil f h -
Group, verage file 5|'ze is about n'me megabytes oreach ||\ titional MPEG
minute of motion picture
.mpg, players
.mpeg)
- QuickTime (Cinepak compression)
- Offers smaller, downloadable files and allows films
to be viewed on lower-end computers
- Not as crisp as the MPEG format
- Average f|Ier;i|rz]e;t|: e:)l:fx::(’;:il(\)/ﬁ rr;cefuart;ytes for each Windows, Mac:
QuickTime P QuickTime
. Wi : Medi
(.mov) - QuickTime 3 (Sorenson compression) indows: Media
Player
- A streaming file format
Enhanced image quality, higher resolution
- Available in Dance Instruction Manuals collection
- Average file size is about six megabytes for each
minute of motion picture
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- A streaming file format

. Windows: Media
- Useful for computers with slower Internet

RealMedia . Player
t
(.rm, .ram) connections Windows, Mac:
RealPlayer

- Playback is slower (three to six frames per second)
and may be affected by Internet traffic.

Topic 13 Video Files on the Library of Congress Website

The American Memory Website has a rich, historic film. We will explore web pages that
use each of the formats we have discussed.

Exercises:

1. MPEG

From the Arrival of Prince Henry [of Prussia and President Roosevelt at Shooter's
Island page on the American Memory site at:
http://memory.loc.gov/ammem/collections/troosevelt film/title.html . Click on the
link for filmed speech of Theodore Roosevelt. Select the MPEG format.

What program is needed for this file format?

2. MOV

On the American Memory site, at Late Nineteenth-Century Dance: Washington Post
Two Step, right click on the link View QuickTime (Cinepak Version):
http://memory.loc.gov/ammem/dihtml/divideos.html#vc007, and download the file
to your webfiles folder.

What size is this MOV file?

What format on this page is the smallest?

Why would someone want a smaller file size?
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3. RAM

From the Library’s web cast of Life Beyond MARC by Roy Tennant at:

http://www.loc.gov/today/cyberic/feature_wdesc.php?rec=3774, right click on the
Launch in New Window link. Select Save target as. Download the file to your download

folder.

What program is needed for this file format?

What are the characteristics of this format?

4. Insert either the .mov or .mpeg film from your download folder into your PowerPoint

presentation. The .ram file requires RealPlayer to play.

Insert>>Video or Audio>>Video or Audio from File.

Insert Design Transitions Animations Slide Show Review View Acrobat
& | D T L [A = s j
— i — = 55 ¥
b PR = 4 55 e
ip Screenshot Photo Shapes Smartart Chart 3 3 Text Header WaordArt Date Slide Object | Equation =
rt - Album ~ = Box & Footer = & Time Mumber =
Images Illustrations Links Text Symbaols

Video Audio

Media

What other uses might you have for the movie file?
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